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Session 2: Advanced Data Entry 
 

At the end of this lesson participants will be able to: 

• Use the trace function to aid in debugging 

• Implement flow control using a navigation field 

• Implement flow control using multiple applications 

• Collect and analyze paradata 

Debugging Techniques 
Diagnosing and fixing bugs in a CSPro application can be tricky. It is often useful to be able visualize the 

values of variables and the flow of the program. You can do this using the errmsg() function. For 

example, if you have code that is building a dynamic value set such as in the health respondent line 

number (C02) we can show a message each time through the loop to display values of the variables we 

are using: 

onfocus 

// Create the value set for respondent from all household members 10 and over 

numeric indexRoster; 

numeric nextEntryValueSet = 1; 

do indexRoster = 1 while indexRoster <= totocc(HOUSEHOLD_MEMBERS_ROSTER) 

    errmsg("indexRoster = %d, nextEntryValueSet = %d, Name = %s",  

            indexRoster, nextEntryValueSet, FIRST_NAME(indexRoster)); 

    if AGE(indexRoster) >= 10 then 

        labels(nextEntryValueSet) = strip(FIRST_NAME(indexRoster)) + " " +  

                                    strip(LAST_NAME(indexRoster)); 

        codes(nextEntryValueSet) = indexRoster; 

        nextEntryValueSet = nextEntryValueSet + 1; 

    endif; 

enddo; 

codes(nextEntryValueSet) = notappl; 

setvalueset($, codes, labels); 

 

This gives us useful information, however, we have to click through a lot of errmsg dialogs to see the 

results. Instead we can use the trace() function. Instead of showing a dialog box for each message, trace 

writes all the messages to a single window that stays visible. To show the trace() window you call 

trace(on). To write a message to the trace window you call trace the same way you would call errmsg: 
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onfocus 

// Create the value set for respondent from all household members 10 and over 

numeric indexRoster; 

numeric nextEntryValueSet = 1; 

trace(on); 

do indexRoster = 1 while indexRoster <= totocc(HOUSEHOLD_MEMBERS_ROSTER) 

    trace("indexRoster = %d, nextEntryValueSet = %d, Name = %s",  

          indexRoster, nextEntryValueSet, FIRST_NAME(indexRoster)); 

    if AGE(indexRoster) >= 10 then 

        labels(nextEntryValueSet) = strip(FIRST_NAME(indexRoster)) + " " +  

                                    strip(LAST_NAME(indexRoster)); 

        codes(nextEntryValueSet) = indexRoster; 

        nextEntryValueSet = nextEntryValueSet + 1; 

    endif; 

enddo; 

codes(nextEntryValueSet) = notappl; 

setvalueset($, codes, labels); 

 

The messages written to the trace window will look like: 

 

In addition to your own messages, CSPro automatically adds messages to the trace window for every 

preproc and postproc that is run. This allows you to see the order of procs that are run and where your 

own trace messages fit in. 

Flow Control 
In long and complex surveys, you often would like to be able to complete sections in the survey out of 

order. For example, if there is no one at home who can answer the health section (C) you could instead 

complete the food security section (D) and later come back to the health section. However, in system-

controlled mode, CSPro forces you to complete the questionnaire in a linear fashion. You must complete 

all prior forms before starting on the next form so you have to complete section C before starting 

section D. There are, however, a couple of ways to work around this behavior to permit answering the 



3 
 

sections out of the usual order. The first technique uses skips to move around the questionnaire and the 

second technique implements a single questionnaire as multiple data entry applications. 

 

Flow Control with a Navigation Field 
The first way to implement flow control in CSPro is to add a navigation field into the application that 

gives the user a list of choices of sections to jump to. To do this, we add a new item in the dictionary 

named NAVIGATION. We can add it to the interview record. The value set will be: 

Section B – 1 

Section C – 2 

Section D – 3 

Section E – 4 

 

We will create a new form named "navigation form" in between section A and section B and drop this 

variable onto it. In the postproc of the field we will use skip to move the section chosen. 

PROC NAVIGATION 

     

onfocus 

 

// Clear previous choice 

$ = notappl; 

 

postproc 

 

// Go to selected section 

if $ = 1 then 

    skip to SECTION_B_HOUSEHOLD_ROSTER_FORM; 

elseif $ = 2 then 

    skip to SECTION_C_HEALTH_FORM; 

elseif $ = 3 then 

    skip to SECTION_D_FOOD_SECURITY_FORM; 

elseif $ = 4 then 

    skip to SECTION_E_CONSUMPTION_FORM; 

endif; 

 

To go back to the navigation field after completing a section we can add a userbar button that uses the 

reenter command to go back to the navigation field. 

First, we need a function in the proc global. 

function GoToNavigation() 

    reenter NAVIGATION; 

end; 

 

Then we need to add this function to the userbar: 

userbar(clear); 

userbar(add button, "Navigation", GoToNavigation); 

userbar(show); 
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Normally we would add the function to the userbar in the form file preproc but in this case we only 

want to show the button when we are already at or past the navigation field, otherwise we might skip 

over some of the id-items. We can do that by placing this code in the preproc of the navigation form. To 

make sure that the userbar button doesn't get shown after adding a case and then starting a new case 

we can add code to clear the userbar in the questionnaire preproc. 

There are consistency checks and roster control fields in section C and D that use values from section B. 

If we skip over section B to section C or D, these consistency checks will fail because the values in section 

B have been skipped and are considered blank. We could try using visualvalue() to access the values but 

not only does this complicate our code, but if the interviewer tries to complete section C before 

completing section B, even with visualvalue, the values will still be blank. To avoid this, we can move the 

navigation form to be after section B. This forces the interviewer to complete section B before using the 

navigation menu. Now in the NAVIGATION postproc we need to use reenter instead of skip for section B. 

postproc 

 

// Go to selected section 

if $ = 1 then 

    reenter SECTION_B_HOUSEHOLD_ROSTER_FORM; 

elseif $ = 2 then 

    skip to SECTION_C_HEALTH_FORM; 

elseif $ = 3 then 

    skip to SECTION_D_FOOD_SECURITY_FORM; 

elseif $ = 4 then 

    skip to SECTION_E_CONSUMPTION_FORM; 

endif; 

 

This allows us to navigate easily but it has a pretty terrible side effect. If we complete sections B and C, 

go to the navigation field and then complete sections D and E we see that the data we entered for 

sections B and C is gone. This is because skipped fields are set to blank when the case is saved. 

To solve this, we can use the advance command to go to the end of the questionnaire without skipping. 

Let's add another option to the value set for NAVIGATION called "Validate and Complete". When the 

interviewer chooses this option, we use advance to go from the NAVIGATION field to the end of the 

questionnaire. Advance will run all of the consistency for all of the fields and will stop if it encounters 

any errors. This will ensure that no sections are left blank and no inconsistencies were added by entering 

data out of order. 
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PROC NAVIGATION 

     

postproc 

 

// Go to selected section 

if $ = 1 then 

    reenter SECTION_B_HOUSEHOLD_ROSTER_FORM; 

elseif $ = 2 then 

    skip to SECTION_C_HEALTH_FORM; 

elseif $ = 3 then 

    skip to SECTION_D_FOOD_SECURITY_FORM; 

elseif $ = 4 then 

    skip to SECTION_E_CONSUMPTION_FORM; 

elseif $ = 9 then 

    // Validate and complete 

    advance; 

endif; 

 

This fixes the problem of skipped fields getting erased, but only if the interviewer makes sure to use the 

NAVIGATION field to select validate and complete. If instead they just complete the final section after 

having skipped earlier sections, the skipped sections will still be erased. To prevent this, we will force the 

interviewer to return to NAVIGATION before completing the questionnaire. We will add a new field 

named QUESTIONNAIRE_COMPLETE and put it on a new form at the end of the questionnaire. In the 

preproc for QUESTIONNAIRE_COMPLETE we will reenter NAVIGATION to force validation. In order to 

allow completion of the questionnaire from the NAVIGATION field, we will add a logic variable named 

inFinalValidation. We will set it to zero in the preproc of NAVIGATION and set it to 1 before calling 

advance. In the preproc of QUESTIONNAIRE_COMPLETE we will check the value of inFinalValidation and 

only return to NAVIGATION if inFinalValidation is false. This way, the only way to get to the end of the 

questionnaire will be to do it by choosing "validate and complete" from NAVIGATION. 
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PROC QUESTIONNAIRE_COMPLETE 

preproc 

 

// Only allow completion of questionnaire if coming 

// from NAVIGATION, otherwise return to NAVIGATION 

if not inFinalValidation then 

    reenter NAVIGATION; 

endif; 

$ = 1; 

 

 

PROC NAVIGATION 

     

preproc 

// By default not in final validation 

inFinalValidation = 0; 

 

onfocus 

 

// Clear previous choice 

$ = notappl; 

 

postproc 

 

// Go to selected section 

if $ = 1 then 

    skip to SECTION_B_HOUSEHOLD_ROSTER_FORM; 

elseif $ = 2 then 

    skip to SECTION_C_HEALTH_FORM; 

elseif $ = 3 then 

    skip to SECTION_D_FOOD_SECURITY_FORM; 

elseif $ = 4 then 

    skip to SECTION_E_CONSUMPTION_FORM; 

elseif $ = 9 then 

    // Validate and complete 

    inFinalValidation = 1; 

    advance; 

endif; 

 

We can make the questionnaire complete field protected and set it to true when the questionnaire has 

been validated. 

We now have a working flow control scheme but we can improve it by showing that status of each 

section in the navigation field. To do that we add a variable in the dictionary for the completion status of 

each questionnaire with complete – 1 and incomplete – notappl. At the end of each section we set the 

status variable for the section to complete. In the NAVIGATION field we can show the status in the 

question text. To ensure that sections do not stay marked as complete when they are modified, we need 

to also set the status to incomplete at the beginning of each section. Since each section is on its own 

form, we can do this in the preproc and postproc of the form for the section. 
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PROC SECTION_D_FOOD_SECURITY_FORM 

preproc 

// Start section, mark incomplete 

SECTION_D_COMPLETE = notappl; 

postproc 

// End section, mark complete 

SECTION_D_COMPLETE = 1; 

  

To show the status in the question text we can use a function for the fill: 

// For displaying section status in question text for 

// navigation field 

function string getSectionStatus() 

 

    getSectionStatus =  

        "Section B: " + getlabel(SECTION_B_COMPLETE_VS1, SECTION_B_COMPLETE)  

        + "<br/>" + 

        "Section C: " + getlabel(SECTION_C_COMPLETE_VS1, SECTION_C_COMPLETE)  

        + "<br/>" + 

        "Section D: " + getlabel(SECTION_D_COMPLETE_VS1, SECTION_D_COMPLETE)  

        + "<br/>" + 

        "Section E: " + getlabel(SECTION_E_COMPLETE_VS1, SECTION_E_COMPLETE); 

 

end; 

 

Note that "<br/>" in question text will add a newline.  

The question text will be: 

You must the complete the following sections of the questionnaire: 
 
%getSectionStatus()% 
 
Choose a section to go to 

 

Now every time we enter the navigation field, we see the status of each of the questionnaire sections. 

Note that we did not put any of the questionnaire status variables onto a form. If we had put them onto 

the form for each section we would have to use visualvalue() to read their values to build the question 

text. When a variable is not on a form, you never have to use visualvalue() since the variable can't be 

skipped or be ahead of the current field. 
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Group Exercise 

Whenever the interviewer runs the GoToNavigation() save the name of the current field for the section 

that they are currently. Then when they restart that section, use advance to move them back to the field 

they were on when they navigated away from that section. For example, if the user is on the field D02 in 

section and they tap "Navigate" on the userbar to work on another section and then use navigate again 

to go back to section D, the program should automatically put them directly into D02 again. 

You will need variables in the dictionary to store the last field for each section: one variable for last field 

in section C, one for the last field in section D, and one for the last field in section E. You can get the 

name of the current field as a string using the function getsymbol() and you can get the name of the 

record that the variable is on using getrecord(getsymbol()). To move to the saved field, use advance to 

the saved field name in the preproc of the form for the section. 

Flow Control with Multiple Applications 
An alternative approach to flow control is to implement each section as a separate application and have 

the main application launch the section applications using execpff() the same way we launch the listing 

and household applications from a menu application. By making each section a separate application, 

each section has its own flow so no fields ever need to be skipped. 

Let's start by moving section C (health) into a separate application. Create a new application named 

"Section C". Put it in a subfolder of the Household folder also named "Section C". Copy the id-items from 

the household dictionary but change the names so they won't conflict when both dictionaries are used 

in the same application e.g. (C_PROVINCE, C_DISTRICT…). Copy the health-related fields from the person 

record into the household dictionary and paste it into a new section C record in the new dictionary with 

the same number of occurrences as the person record. Create forms in the section C application 

containing the id-items and the section C record. 

Copy the logic and question text for section C from the household application into the new application. 

In order for the logic to work correctly we need to access the variables in the household dictionary from 

the section C application. To do that, add the household dictionary as external dictionary in the section C 

application. In the postproc of C_HOUSEHOLD_NUMBER use loadcase to load the household roster: 

PROC C_HOUSEHOLD_NUMBER 

 

// Load the case from the main household file to get access to the household 

roster 

if not loadcase(HOUSEHOLD_DICT, C_PROVINCE, C_DISTRICT, C_CLUSTER,  

                C_HOUSEHOLD_NUMBER) then 

    errmsg("Invalid household identifiers"); 

    stop(1); // Back to menu application 

endif; 

 

You will need to fix errors and warnings in logic mainly due to the fact that since the health questions 

and the household roster items are no longer in the same record (or even the same dictionary), we need 

to use subscripts to correctly access the household roster variables. To make the question text fills work 

correctly, copy the getFullName() function from the logic of the household application and modify it to 

use curocc() as a subscript for FIRST_NAME and LAST_NAME. 
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To correctly size the roster in section C we need to add a new singly occurring record containing a 

variable for the number of household members, drag the variable onto the form before the roster and 

use it as the roster control field. Copy the value from the NUMBER_OF_HOUSEHOLD_MEMBERS variable 

in the household dictionary into this new variable. 

The next step is to launch the section C application from the household application. Modify the pff for 

the section C application using the pff editor to set the start mode to add and set the OnExitPff to 

relaunch the household questionnaire when the section C program exits. Use the pff editor to generate 

the CSPro logic to write out the pff. Modify the pff generation code to add the values of the id-items as 

parameters in the pff file. 

 

function LaunchSectionC() 

 

    FILE pffFile; 

     

    setfile(pffFile,"SectionC/SectionC.pff",create); 

 

    filewrite(pffFile,"[Run Information]"); 

    filewrite(pffFile,"Version=CSPro 7.2"); 

    filewrite(pffFile,"AppType=Entry"); 

 

    filewrite(pffFile,"[DataEntryInit]"); 

    filewrite(pffFile,"StartMode=Add"); 

    filewrite(pffFile,"ShowInApplicationListing=Never"); 

 

    filewrite(pffFile,"[Files]"); 

    filewrite(pffFile,"Application=%s","./SectionC.ent"); 

    filewrite(pffFile,"InputData=%s", 

                      "../../Data/HouseholdSectionC.csdb|CSPRODB"); 

 

    filewrite(pffFile,"[ExternalFiles]"); 

    filewrite(pffFile,"HOUSEHOLD_DICT=%s", 

                      "../../Data/Household.csdb|CSPRODB"); 

 

    filewrite(pffFile,"[Parameters]"); 

    filewrite(pffFile,"PROVINCE=%v",PROVINCE); 

    filewrite(pffFile,"DISTRICT=%v",DISTRICT); 

    filewrite(pffFile,"CLUSTER=%v",CLUSTER); 

    filewrite(pffFile,"HOUSEHOLD_NUMBER=%v",HOUSEHOLD_NUMBER); 

    filewrite(pffFile,"OnExit=%s","../PopstanHouseholdSurvey.pff"); 

 

    close(pffFile); 

 

    execpff(filename(pffFile),stop); 

 

end; 

 

Modify the postproc of NAVIGATION to launch the section C application: 
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postproc 

 

// Go to selected section 

if $ = 1 then 

    reenter SECTION_B_HOUSEHOLD_ROSTER_FORM; 

elseif $ = 2 then 

    savepartial(); 

    launchSectionC(); 

elseif $ = 3 then 

 

Note that we must call savepartial() before launching the section C application so we do not lose any 

data. 

Back in the section C application, modify the preproc of the questionnaire for the section C application 

to read the parameters from the pff file and assign them to the id items in the section C. 

PROC SECTIONC_QUEST_FORM 

 

preproc 

// Copy id-items passed to use from household application via pff file 

C_PROVINCE = tonumber(sysparm("PROVINCE")); 

C_DISTRICT = tonumber(sysparm("DISTRICT")); 

C_CLUSTER = tonumber(sysparm("CLUSTER")); 

C_HOUSEHOLD_NUMBER = tonumber(sysparm("HOUSEHOLD_NUMBER")); 

 

Follow the same procedure to create separate data entry applications for sections D and E. 

The postproc for NAVIGATION should now look like: 

postproc 

 

// Go to selected section 

if $ = 1 then 

    reenter SECTION_B_HOUSEHOLD_ROSTER_FORM; 

elseif $ = 2 then 

    savepartial(); 

    launchSectionC(); 

elseif $ = 3 then 

    savepartial(); 

    launchSectionD(); 

elseif $ = 4 then 

    savepartial(); 

    launchSectionE(); 

elseif $ = 9 then 

    // do nothing which falls through to end of questionnaire 

endif; 

 

Note that we no longer need the advance to complete the questionnaire. Since NAVIGATION is now the 

last field in the household questionnaire application, we can simply allow the program to end by doing 

nothing. For all other selections, one of the section applications will be launched instead. 
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To update the completion status of the section we have to add the dictionary for the section application 

as an external dictionary to the household application and use loadcase to check if the case has been 

completed in that dictionary. This can be done in the onfocus of NAVIGATION since that is where the 

completion status is displayed. 

onfocus 

 

// Clear previous choice 

$ = notappl; 

 

// Update completion statuses for sections 

if loadcase(SECTIONC_DICT, PROVINCE, DISTRICT, CLUSTER, HOUSEHOLD_NUMBER) and 

not ispartial(SECTIONC_DICT) then 

    SECTION_C_COMPLETE = 1; 

else 

    SECTION_C_COMPLETE = notappl; 

endif; 

 

By using multiple applications, we have a control flow that does not require skips that could erase data. 

The disadvantage of this approach is that our data is now spread out among multiple data files. We will 

see how we can combine these data files together next week using a batch edit application. 

Group Exercise 

Create a separate application for section D that is launched from the household data entry application. 

Make sure that the correct completion status is shown in the question text for the NAVIGATION field. 

 

Paradata 
Paradata is data about the data collection process itself. This includes the time taken to answer each 

question, number of validation errors as well as information about the device itself. This information can 

be analyzed to find ways to improve your data entry instrument, field procedures and training. Paradata 

is saved to a paradata log file with the extension .cslog. 

Collecting paradata 
You can choose which types of paradata to collect in the paradata options dialog in the CSPro designer. 

You can choose to collect all possible paradata events, no paradata at all or you can select which 

individual events to collect. Many paradata events occur very frequently so collecting every event can 

result in very large paradata log files. In addition, some events may result in confidential information 

being written to the log such as field values and GPS coordinates. In some surveys you want not want to 

collect that data for privacy reasons. For our application we will choose to collect all paradata events in 

order to have as much data as possible to analyze. 

Before we can analyze any paradata, we need to collect some by doing a few interviews. Let's have 

everyone take a phone or tablet, load the latest version of the application on it and interview three 

made up households. So that we get interesting GPS data, please conduct each interview in a different 

part of the hotel grounds. 
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Concatenating paradata 
After collecting the data, we can combine the paradata log files from each tablet together using the 

Paradata Concatenator tool. We copy the paradata log from each tablet via usb to a laptop and then add 

each one the paradata file to the concatenator and run the concatenation. The result is single paradata 

log containing the data from all the tablets. 

Viewing paradata 
Double clicking on a paradata log file opens it in the Paradata Viewer. The viewer contains a number of 

built-in reports as well the ability to create your own customized reports. To run a built-in report simply 

click on the name of the report in the list of reports on the left-hand side of the screen. The result is 

displayed on the right. Some reports can be shown as charts in addition to as tables. 

The first report, "Field Entry Information", shows the number of times each field in the questionnaire 

was entered as well as the average amount of time spent on each field. This can tell you which questions 

take the longest to answer as well as which fields interviewers make the most mistakes entering and are 

forced to reenter. 

Too look at interview times see the "Sessions by Case ID" report which shows the total time in minutes 

spent on each case. You can use this data to figure out the average interview time. 

Another interesting report is the "Displayed Message Frequency" which shows you how frequently each 

of the error messages in the application is shown. It indicates how often each consistency check is 

triggered. 

Any report can be filtered using the filters on the left-hand side of the screen.  You can filter by a date 

range, by user, by device, by application name etc… Selecting any of these filters limits the data to 

generate the report to the data that meets the filter criterion. 

Custom queries 
In addition to the built-in reports, you can view the raw data itself. From the view menu, choose "Table 

Browser". The paradata is stored in a relational database and this lets you see the tables in that 

database. If you click on the device_info table, for example you can see the raw data for information for 

all the devices used. Many of these tables are not useful by themselves. The tables are normalized, 

meaning that they need to be joined with other tables to get usable data. For example, the 

field_movement_event table has a column field_movement_instance, which refers to a row in the 

field_movement_instance table. In addition, all of the event tables are linked by id to the base event 

table which contains data common to all the different types of events. To include all the data from the 

linked tables, choose "Show Fully Linked Tables" from the "Options" menu. You can also see detailed 

information about each table by choosing "View"→"Table metadata". In this mode you can see 

information each of the columns in each table as well as the linkages between tables. At the bottom of 

the screen you can see the SQL queries used to select from and join the different tables.  
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To execute your own SQL queries, you can choose "Query Constructor" from the "View" menu. You can 

then write and execute SQL queries. For example, if we want to see how many devices of each brand 

were used, we can execute the following SQL: 

SELECT device_brand, count(*) as num_devices  

from device_info  

group by device_brand 

 

You can add your own queries into the list of reports by editing the file C:\Program Files (x86)\CSPro 

7.2\Reports\CSPro Reports.csrs. This file contains the SQL and other information for all of the built-in 

reports. You will need administrative privileges on your computer to modify this file. 

Plugins 
Since we have collected GPS data in our paradata log we can also view the GPS points on a map. To do 

that, choose "Location Mapper" from the "View" menu. This will prompt you to download the location 

mapper plugin. Currently this is the only plugin for data viewer but if you know the C# programming 

language and how to use the SQLite database it is possible to write your own plugins and add them to 

the Paradata Viewer. 

Custom events 
Finally, if the built-in paradata events are not sufficient, you can log your own events to the paradata file 

using the logtext command. Logtext works like errmsg or trace except that message is written to the 

paradata file. For example, if we want to see how often interviewers navigate to different sections of the 

questionnaire using the navigation field, we can add calls to logtext in the postproc of NAVIGATION: 

postproc 

 

// Go to selected section 

if $ = 1 then 

    logtext("Navigate to section B"); 

    reenter SECTION_B_HOUSEHOLD_ROSTER_FORM; 

elseif $ = 2 then 

    logtext("Navigate to section C"); 

    skip to SECTION_C_HEALTH_FORM; 

elseif $ = 3 then 

    logtext("Navigate to section D"); 

    skip to SECTION_D_FOOD_SECURITY_FORM; 

elseif $ = 4 then 

    logtext("Navigate to section E"); 

    skip to SECTION_E_CONSUMPTION_FORM; 

elseif $ = 9 then 

    logtext("Validate and complete"); 

    // Validate and complete 

    inFinalValidation = 1; 

    advance; 

endif; 
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The individual messages we write using logtext can be viewed using the Logged Event Frequency report. 

If we want to see total calls to each message, we can use the following query: 

SELECT  

text.text, count(*) as num 

FROM message_event 

JOIN text ON message_event.message_text = text.id 

WHERE message_event.source = 3 

group by message_text 

 

Syncing paradata  
Currently the only way to synchronize paradata is to use syncfile() to send the whole paradata log file 

each time. Since the paradata log get can quite large, you may want to limit the events collected if you 

wish to sync the paradata. Another option to use the logic function sqlquery() to query only the data 

you need from the paradata file and copy the results into the data file to have it synced. 

Exercises 
Use the paradata viewer to answer the following questions: 

- How many cases were reopened (opened in modify mode)? 

- Which user took the most total time entering data? 

- What is the lowest battery level of all devices used? 

- Which device had the lowest average battery level? 

 

 


